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1  Introduction 
This guide describes tasks that are performed by a system administrator to install or upgrade 
the Empirica™ Signal application. This guide is intended for use by system administrators or 
database administrators who are familiar with Oracle relational databases and who host the 
Empirica Signal application at their own installations, rather than contracting for this service from 
Oracle. 

The topics covered in this guide are: 

• Installing Empirica Signal release 7.3.3.5.362 

• Upgrading from Empirica Signal 7.2 to release 7.3.3.5.362 

• Upgrading from Empirica Signal release 7.3 (7.3.333, 7.3.337, 7.3.341, 7.3.3.0.354, 
7.3.3.1.356, 7.3.3.2.359 or 7.3.3.3.360) to release 7.3.3.5.362 

• Upgrading from Empirica Signal release 7.3.3.4.361 to release 7.3.3.5.362 

This guide assumes familiarity with the process of setting Windows file permissions, 
administering IIS, configuring Windows Services, and setting up and configuring Oracle. 

You perform all of the steps described on the Windows 2003/2008 server that will host the 
Empirica Signal application.  

Note: Before beginning the Empirica Signal installation, you should review the Empirica Signal 
Secure Configuration Guide for recommendations on installing the Empirica Signal application 
and its system components securely. 
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2 Installing Empirica Signal release 
7.3.3.5.362 

To install the Empirica Signal application, you perform steps to do the following: 

• Set up the database. 

• Install the Empirica Signal software. 

• Configure properties files. 

• Configure the Empirica Signal application. 

• Install report data. 

Optionally, you can also: 

• Install the sample topic workflow configuration. 

• Install test data and verify the Empirica Signal installation. 

Before you begin an Empirica Signal installation, you need the following: 

• A username with admin privileges for the Windows 2003 SP2 or Windows 2008 server, and 
its password. 

• The correct version from the Oracle Software Delivery Cloud. 

• Oracle 10g or Oracle 11g R2 installed on the server, and at least one reboot of the server 
since the Oracle installation. 

• Any ZIP archive manager (for example, the WinZip application). 

• Internet Explorer 7.x, 8.x or 9.x. 

• The “sys” and “system” passwords for the Oracle instance. 

• Identification of the server as a 32-bit or 64-bit server. 

• For each script that you run, the script produces a log file with the same name as the script 
in the current directory. 

• Note: As part of this installation, you set up several Oracle accounts, including a webvdme 
account and TOPIC_WORKFLOW account, as well as at least one data account and at 
least one dictionary account. Oracle 11g includes a default setting that requires you reset 
passwords for these accounts every six months. 

2.1  Set Up the Database 

2.1.1  Setting Up the Oracle Net Service Name 
Create a TNS Name Entry named webvdme that points to the Oracle instance that will contain 
the Empirica Signal data. 

Use the Net Manager to set up the webvdme Oracle Net Service name: 
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1. Launch the Oracle > Configuration and Migration Tools > Net Manager program. 

2. Click to expand the Local node, and then select the Service Naming node.  

3. Create a new service name by either selecting Edit > Create or clicking the Create icon 
(green plus sign) at left.  

The Net Service Name wizard opens. 

4. For the Net Service Name, type webvdme, and then click Next. 
5. For the Protocol, select TCP/IP (Internet Protocol), and then click Next. 
6. For the Hostname, supply localhost, and for the Port, type 1521, and then click Next. 
7. If you are installing on Oracle 10g, select the Oracle 8 or Previous radio button, and for the 

SID supply the SID for your specific database (e.g. ORCL), and then click Next. 
If you are installing on Oracle 11g, for the Service Name field type ORCL, and for the 
Connection Type select Dedicated Server. 

8. Test if desired, and then click Finish.  

The settings you specified for the webvdme service display on the right. 

9. From the File menu, select Save Network Configuration, and then close Oracle Net 
Manager. 

2.1.2  Setting Up the Empirica Signal Oracle Account 
Supplied Empirica Signal installation scripts create the necessary Oracle tablespaces and 
accounts, and supply account contents to support Empirica Signal. 

1. Locate the database.zip file in the product ZIP file from the Oracle Software Delivery 
Cloud and extract the contents of this file to a temporary location, such as 
C:\install\database. 

2. Verify that the DEFINE statements in the 1_create_webvdme_tablespaces.sql file point to 
your preferred location for the tablespace data files. For example, if you are installing with 
Oracle 11g, open this file with Notepad and review these lines: 
DEFINE oracle11_datafile_path = 
'D:\oracle\product\11.2.0\dbhome_1\oradata' 

DEFINE datafile_path = &oracle11_datafile_path 

3. Edit these lines if needed to reflect your path.  

4. Open a Command Prompt window and execute the 1_create_webvdme_tablespaces SQL 
script from the Oracle sys account. For example, enter: 
C:> sqlplus "sys@webvdme as sysdba" 

@C:\install\database\1_create_webvdme_tablespaces 

5. When prompted, enter the Oracle sys account password.  
 

6. Enter: 
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C:> sqlplus "sys@webvdme as sysdba" 
@C:\install\database\2_create_webvdme_oracle_user 

7. When prompted, enter the Oracle sys account password. When prompted a second time, 
create a password of your choice for the webvdme account and re-enter to verify. 
Remember this password. 

8. At the Command Prompt execute the 3_create_all SQL script from the webvdme 
account. For example: 
C:> sqlplus webvdme@webvdme @C:\install\database\3_create_all 

9. When prompted, enter the webvdme database account password that you created in the 
previous step.  

2.1.3 Setting Up the Sample Topic Workflow Oracle Account (optional) 
The supplied Empirica Signal installation scripts create the necessary Oracle tablespaces and 
account, and supply account contents to support Empirica Signal Topics. 

1. At the Command Prompt execute the create_topics_oracle_user SQL script from the 
sys account. For example: 
C:> sqlplus "sys@webvdme as sysdba" 
@C:\install\database\create_topics_oracle_user 

2. When prompted, enter the Oracle sys account password. When prompted a second time, 
create a password of your choice for the TOPIC_WORKFLOW account and re-enter to 
verify. Remember this password. 

3. At the Command Prompt execute the create_sample_topics_tables SQL script from the 
TOPIC_WORKFLOW database account created in the previous step. For example: 
C:> sqlplus topic_workflow@webvdme 

@C:\install\database\create_sample_topics_tables 

4. When prompted, enter the TOPIC_WORKFLOW database account password. 

5. At the Command Prompt execute the populate_sample_topics_tables SQL script from 
the TOPIC_WORKFLOW database account in step 1. For example: 
C:> sqlplus topic_workflow@webvdme 

@C:\install\database\populate_sample_topics_tables 

6. When prompted, enter the TOPIC_WORKFLOW database account password. 
 

2.2 Install Empirica Signal Software 

2.2.1  Installing Prerequisite Files 
To install the Microsoft Visual C++ 2005 SP1 Redistributable Package (x86): 

1. Locate the vcredist_x86.exe file in the product ZIP file from the Oracle Software Delivery 
Cloud. 
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2. Double-click the vcredist_x86.exe file.  

3. Click Yes and complete the installation. 

2.2.2  Setting Up Web Site Files 
1. Locate the Lincoln_x64.zip file in the product ZIP file from the Oracle Software Delivery 

Cloud. For a 32-bit server, use Lincoln.zip instead. Extract the contents of this file to C:\, 
making sure that path names stored in the archive will be used (for example, in WinZip, the 
Use folder names checkbox must be selected). 

2. Locate the SignalX.zip file (where X represents the version number and build, for 
example, Signal-7_3_3_5_362.zip) in the product ZIP file from the Oracle Software 
Delivery Cloud. Extract the contents of this file to the 
C:\Lincoln\apps\webvdme\webapps\web_root\ directory (created automatically by the 
previous step). 

3. Locate the following file depending on your Oracle database version: 

• If you are using Oracle 10g, local the ojdbc14.jar file in the \jdbc\lib folder of the 
Oracle installation directory. 

• If you are using Oracle 11g, locate the ojdbc6.jar file in the \jdbc\lib folder of the 
Oracle installation directory.  

4. Copy the JAR file to the C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\lib 
directory. 

5. Navigate to the C:\Lincoln\IIS\conf\iis_redirect.reg file. If you changed any default 
paths, edit this file to reflect those paths before performing the next step. 

6. To update the registry, double-click the iis_redirect.reg file. Click Yes, and then click 
OK. 

7. In the same directory, double-click the iis_cipher_configuration.reg file. Click Yes, 
and then click OK. 

8. Create a temp directory for the application, for example, D:\Signal.  

Make note of this directory, as it will be needed in several future steps in the installation. 

2.2.3  Making Empirica Signal the Default Application (optional) 
1. Open the C:\Lincoln\apps\webvdme\webapps\web_root\index.html file in a text editor 

such as Notepad and change the URL on this line from: 
<META HTTP-EQUIV=REFRESH CONTENT="0; URL=./login.jsp"> 

to: 
<META HTTP-EQUIV=REFRESH CONTENT="0; URL=/webvdme/login.jsp"> 

Then save. 
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2. To make Empirica Signal the default application for this IIS installation, copy the 
C:\Lincoln\apps\webvdme\webapps\web_root\index.html file to the 
C:\inetpub\wwwroot directory.  

2.2.4 Configuring IIS for Windows 2003 SP2 
This section is for Windows 2003 SP2 Server only. If you are using Windows 2008, skip to 
section 2.2.5, Configuring IIS for Windows 2008. 

1. Launch Start [/ Settings] / Control Panel / Administrative Tools / Internet [Information] 
Services (IIS) Manager. 

2. Expand the Web Sites tree until you see Default Web Site, then right click Default Web Site 
and select Properties. 

3. On the ISAPI Filters tab, click Add. Add a filter with the following characteristics: 

Filter Name: jakarta 
Executable: C:\Lincoln\IIS\bin\isapi_redirect.dll 
If making Empirica Signal the Default Application, select the Documents tab, check the 
“Enable Default Document [Content]” checkbox and set index.html as the top-most default 
document. (Add this document if necessary.) 
On exiting the Properties dialog for Default Web Site, if you do not want to override the 
default document settings for any other virtual directories (e.g., Printers), click OK. 

4. Right click Default Web Site and select New / Virtual Directory. Set up a virtual directory for 
jakarta as follows: 

Alias:  jakarta 
Directory [Path]:  C:\Lincoln\IIS\bin 
Access Permissions: check the “Read” and “Execute” checkboxes only 

5. Enable the jakarta Web Service Extension  

a. Open the IIS Manager Console. 

b. Select the Web Service Extensions node. 

c. Right-click the Add a new Web service extension link. 

d. Set the Extension name to jakarta. 
e. Add the C:\Lincoln\IIS\bin\isapi_redirect.dll file to the required files list. 

f. Check the “Set extension status to Allowed” checkbox. 

g. Click OK. 

Note: No other Web Service Extensions are required for the application to function. 
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6. Right-click Default Web Site and select New / Virtual Directory. Set up a virtual directory 
for webvdme as follows: 

Alias:  webvdme 
Directory:  C:\Lincoln\apps\webvdme\webapps\web_root 
Access Permissions: select the Read checkbox only 

7. Make index.html the default document for the webvdme virtual directory. 

a. Right-click the webvdme virtual directory and select Properties. 

b. Select the Documents tab, select the Enable Default Document [Content] checkbox 
and set index.html as the top-most default document. 

8. Restart the World Wide Web Publishing Service as follows: 

Launch Start / Settings / Control Panel / Administrative Tools / Services. Right-click the 
World Wide Web Publishing Service, and select Restart.  
Alternatively, open a Command Prompt window as Administrator and enter the following: 
net stop w3svc 

net start w3svc 

2.2.5 Configuring IIS for Windows 2008 
This section is for Windows 2008 Server only. 

2.2.5.1 Set up required IIS roles 
1. Launch Server Manager. 

2. If not already present, add the Web Server (IIS) role. 

3. Right-click Web Server (IIS), and select Add Role Services. 

4. Select the following additional options under Application Development: 
CGI 
ISAPI Extensions 
ISAPI Filters 

5. Click Next. 
6. Click Install. 
7. Click Close. 

2.2.5.2 Configure IIS  
1. Navigate to Start > Administrative Tools > Internet Information Services (IIS) Manager. 
2. Select your server name in the Connections pane. 

3. Double-click ISAPI and CGI Restrictions under IIS. 

4. On the Actions pane, click Add. 
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5. On the ISAPI or CGI Restrictions pop-up, complete the following: 
 
ISAPI or CGI Path:  C:\Lincoln\IIS\bin\isapi_redirect.dll 
Description: jakarta 

6. Select Allow extension path to execute and click OK. 
7. Select Default Web Site under your server name on the Connections pane. 

8. Double-click ISAPI Filters. 
9. Click Add from the Actions pane and key in the following characteristics: 

 
Filter name:  jakarta 
Executable:  C:\Lincoln\IIS\bin\isapi_redirect.dll 

10. Click OK. 

11. Right-click Default Web Site and select Add Virtual Directory. 

12. Type the following: 
 
Alias: jakarta 
Physical Path: C:\Lincoln\IIS\bin 

13. Click OK. 

14. Select jakarta, and then double-click Handler Mappings. 

15. In the Actions pane, select Edit Feature Permissions. 

16. Ensure that Execute is selected and click OK. 
17. Right click Default Web Site and select Add Virtual Directory. 

18. Type the following: 
 
Alias: webvdme 
Physical Path: C:\Lincoln\apps\webvdme\webapps\web_root 

19. Click OK. 

2.2.5.3 Configure IIS to show detailed error messages from Tomcat 
1. Navigate to Start > Administrative Tools > Internet Information Services (IIS) Manager. 

2. In the Connections pane, expand the tree for Sites, and select the Default Web Site. 

3. In the IIS section, double-click Error Pages. 

4. In the Actions pane, click Edit Feature Settings. 

5. In the Edit Error Pages Settings dialog box, select Detailed errors. 

6. Click OK. 
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7. Restart the World Wide Web Publishing Service (W3SVC). 

2.2.6  Installing the webvdme keys and service 
1. For Windows 2003 SP2 only, update the lcalcs.exe utility by following the instructions 

located at http://support.microsoft.com/kb/943043. 

2. For both Windows 2003 SP2 and 2008, edit the 
C:\Lincoln\apps\webvdme\bin\install_service.bat file so that the WORKING_DIR is 
the value of the temporary directory from section 2.2.2 Setting Up Web Site Files. Save. 

3. For Windows 2008, right-click the install_service.bat file, and then select Run as 
administrator.  
Or 

For Windows 2003, double-click the install_service.bat file. 

4. After install_service.bat has completed, when prompted, type any key. 

5. For Windows 2008, right-click the C:\Lincoln\apps\webvdme\bin\generate_keys.bat 
file, and then select Run as administrator. 
Or 

For Windows 2003, double-click the 
C:\Lincoln\apps\webvdme\bin\generate_keys.bat file. 

6. After generate_keys.bat has completed, when prompted, type any key. 

7. Right-click the server’s desktop My Computer icon, and then select Manage. 

8. For Windows 2008, expand Configuration > Local Users and Groups > Users, and for 
Windows 2003 SP2, expand System Tools > Local Users and Groups > Users. 

9. Right-click webvdme_app and select Set Password. 

10. In the Set Password for webvdme_app dialog box, click Proceed. 

11. Change the password to satisfy site password policy restrictions, and then click OK. 

12. Expand the Services and Applications directory, and then click Services. 

13. Right-click the webvdme service and select Properties. 

14. On the Log On tab, do the following: 

a. Select the This account radio button. 

b. Click Browse. 

c. Enter webvdme_app in the Edit field. 

d. Click the Check Names button. 

e. Click OK. 

f. Clear the password fields and enter the webvdme_app password you just changed. 

15. On the Recovery tab, set First Failure and Second Failure to Restart the Service. 

http://support.microsoft.com/kb/943043
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16. Click OK. 

17. In the product ZIP file from the Oracle Software Delivery Cloud, copy the 
lt_DiskUtil_x64.dll file to the following location and rename this file to 
lt_DiskUtil.dll. For a 32-bit server, copy lt_DiskUtil.dll instead. 

 
For Windows 2003 SP2 and Windows 2008: C:\windows\system32 

Note: If the file already exists in that directory, overwrite it. 

2.3  Configure Properties Files 

2.3.1  Reviewing webvdme.properties 

The webvdme.properties file stores database connection information for the Empirica Signal 
application.  

1. Navigate to C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\classes. 

2. Copy the template_webvdme.properties file to the same directory, and name it 
webvdme.properties. 

3. Use a text editor such as Notepad to open the webvdme.properties file. 

4. Review the settings for the following values in the file: 
user=webvdme 

pass=<password> 

connect=jdbc:oracle:thin:@//localhost:1521/ORCL 
sqlldr_connect=webvdme 

5. Modify the password to match the password established in 2.1.2 Setting Up the Empirica 
Signal Oracle Account step 7.  

6. Modify temp_dir=<temporary directory> with the value of the temporary path established in 
2.2.2 Setting Up Web Site Files. 

7. Save the file. 

Note: You can set the Empirica Signal application to encrypt this password. See the steps in the 
Configure the Empirica Signal Application section. 

2.3.2  Reviewing listener.properties 
The listener.properties file stores information used by Empirica Signal data mining. 

1. Navigate to C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\classes. 

2. Copy the template_listener.properties file to the same directory, and name it 
listener.properties. 

3. Use a text editor such as Notepad to open the listener.properties file. 

4. Edit values as needed, for example, values for Oracle 10g or Oracle 11g. 
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5. Save the file.  

2.3.3 Creating webvdme-fonts.properties 
The webvdme-fonts.properties file stores font information used by Empirica Signal.  

1. Navigate to the C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\classes 
directory. 

2. Copy the template_webvdme-fonts.properties file to the same directory, and rename it 
webvdme-fonts.properties. 

2.3.4 Setting permissions 
1. Navigate to C:\Lincoln\apps\webvdme\bin. 

2. Edit the C:\Lincoln\apps\webvdme\bin\set_permissions.bat file so that the 
WORKING_DIR is the value of the temporary directory from section 2.2.2 Setting Up Web 
Site Files.  

3. Optionally grant permission to a Windows group of non-administrator users who may require 
limited access to the \web_root application directory. You may grant access to users who 
execute Signal Management and deploy data releases. For example, a non-administrator 
user who copies the data release notes to the \web_root\relnotes directory requires this 
limited access. Do the following: 

a. While editing the set_permissions.bat file, locate the following lines: 
REM - 

REM - Local Administrators group 

REM - 

REM SET ADMIN_GROUP=Signal Operators 

b. Remove REM from the REM SET ADMIN_GROUP line. 

c. Replace Signal Operators with the appropriate Windows user group that requires 
access. 

4. Save your changes. 

5. For Windows 2008, right-click the set_permissions.bat file, and then select Run as 
administrator. 
Or 

For Windows 2003, double-click the set_permissions.bat file. 

6. After set_permissions.bat has completed, when prompted, type any key. 

2.4 Start the Empirica Signal Service 
Start the webvdme service in the Services Control Panel. 
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2.5  Configure the Empirica Signal application 
Before users can begin using the Empirica Signal application, you must complete the following 
tasks. See the Empirica Signal User Guide for more details on how to accomplish each step. 

1. To test that the site is set up properly, open Internet Explorer. If you made Empirica 
Signal the default application for IIS, enter: 
http://<server name> 

Otherwise, navigate to: 
http://<server name>/webvdme 

Note: If your site is configured to require SSL connections, use https:// instead of 
http://. 
The Empirica Signal login page should display.  

2. Log in to Empirica Signal using the default administrative account and initial password 
provided by Oracle:  

Username: admin 

Password: abc123 
3. Change your password. 
4. Log in to the Empirica Signal using the default administrative account and the new password 

from step 3. The Empirica Signal home page should display. 

5. Click Settings and then click Set Site Options. Verify the SMTP server name and other 
options for your site on this page. Ensure that all site options are set appropriately for your 
installation. 

6. Optionally, set Empirica Signal to encrypt the database password: click Settings then click 
Set Database Connection. 

Enter your username and password, and then select Encrypt Password. 

7. Log out of Empirica Signal: click Exit. 
The Empirica Signal software installation is complete.  

2.6  Install Report Data 
To use the standard reports provided with Empirica Signal 7.3, a small data “stub” must be 
installed in the oracle database. This section describes how to install the necessary 
configuration, AERS (1q03: S). You should not perform this procedure if you already have 
installed a copy of the AERS68_TO_1Q03 data set on the server that hosts Empirica Signal. 

The product ZIP file for the Empirica Signal application includes a Data_Stub folder containing 
wvprod.zip, which is a WinZip archive file containing an Oracle DMP file, a SQL script, and a 
batch file. 

You perform all of the steps described in this section on the server that hosts Empirica Signal.  
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2.6.1  Unzipping the Archive file 
1. Create a new directory on the server named wvprod (for example, C:\wvprod\). 

2. Copy the wvprod.zip archive file from the Data_Stub folder in the product ZIP file to the 
new wvprod directory.  

3. Use WinZip to extract the zipped files into the wvprod directory.  

4. The C:\wvprod\ directory should contain an Oracle DMP file of the data, a SQL script, an 
IMP file, and a batch file.  

2.6.2  Creating Tablespaces and Accounts 
To create the tablespaces and accounts used to store the production data: 

1. Open the C:\wvprod\create_prod.sql file in a text editor such as Notepad. By default, 
this script will store tablespace files in the D:\oracle\product\10.2.0\oradata\orcl 
directory. 

2. If necessary, edit the paths in the DATAFILE section of this script to indicate a different 
location for the Oracle tablespace data files.  

The specified path must already exist on your computer, and can be in any location, 
although conventionally it is in a subdirectory of the oradata subdirectory of your Oracle 
installation.  

3. Open a Command Prompt window. 

4. Change to the wvprod directory (for example, cd C:\wvprod). 

5. Execute the script. On one line, type: 
C:> sqlplus system@webvdme @create_prod 
 
Enter the Oracle system account password when prompted. 

6. Exit from SQL: 
SQL> exit 

The create_prod.sql script creates a tablespace for the data consisting of one 40 MB data 
file. 

2.6.3  Importing the Data 
To load the data into Oracle: 

1. Edit the load_prod.imp file to supply your Oracle instance at the end of the userid line. For 
example: 
userid=AERS68_TO_1Q03/<password>@orcl 

2. Execute the batch file: 
C:\wvprod> load_prod.bat 
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2.6.4  Importing AERS (1Q03: S) Configuration 
To import the supplied standard configuration into Empirica Signal: 

1. Log in to Empirica Signal with the admin username.  

2. Click Settings and then click Manage Configurations.  

3. Click Import Configurations. 

4. Supply the following account name and password: 

Oracle Account: AERS68_TO_1Q03 
Oracle Password: <password> 

5. Click OK. 
6. Verify that the AERS (1q03: S) standard configuration is listed on the Manage 

Configurations page. 

7. On the Manage Configurations page, click  and select Edit in the popup menu that 
appears. 

8. On the Modify Configuration page, click Validate Now. 

9. Check “Ignore Warnings” and click Validate Now again. You can ignore the warning 
message about the hierarchy account for the PT variable; the message does not 
prevent the validation from completing. 

10. Click Continue. 

For more information on working with configurations, see the Empirica Signal online help. 

2.6.5  Deleting the C:\wvprod Directory 

When you have completed all of the installation procedures, you can delete the wvprod 
directory and its contents. 

2.7  Import the Sample Topic Workflow Configuration 
(optional) 

This section describes how to import the “Sample Topic Workflow Configuration” for use in 
Empirica Signal. This step is not essential, but it is recommended so that you will have a sample 
configuration to copy and use as a template for new configurations. The sample configuration 
itself should not be edited. 

To import the supplied Sample Topic Workflow configuration into Empirica Signal: 

1. Log in to Empirica Signal with the admin username.  

2. Click Settings, and then click Manage Topic Workflow Configurations.  

3. Click Import Workflow Configurations. 
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4. Supply the following account name and password: 

Oracle Account: TOPIC_WORKFLOW 
Oracle Password: <TOPIC  WORKFLOW password> 

5. Click Import. 
6. Verify that the Sample Topic Workflow Configuration is listed on the Manage Topic 

Workflow Configurations page.  

For information about working with topic workflow configurations, see the Empirica Signal online 
help. 

2.8 Install Test Data 
This section describes optional procedures for installing test data and verifying that Empirica 
Signal is working properly. 

2.8.1  Installing the Test Database 
1. Locate the files you extracted from the database.zip file to create and populate the 

Empirica Signal Oracle account. For example, C:\install\database.  

2. If you have an existing TEST_IQOQ account, drop the existing TEST_IQOQ Oracle account. 
Open a Command Prompt window, enter the drop command for that account, and then exit. 
For example: 
sqlplus system@webvdme 

At the prompt, enter the TEST_IQOQ password. 
drop user TEST_IQOQ cascade; 

exit 

3. To create the Oracle tables in a TEST_IQOQ Oracle account, execute the following SQL 
script as the Oracle system user. Enter this command on one line. For example: 
sqlplus system@webvdme @C:\install\database\4_create_test_iqoq_oracle_user 

At the prompt, enter the system password.  

4. At the second prompt, create a password for the TEST_IQOQ account and re-enter to verify. 
Remember this password. 

5. To populate the test database in the TEST_IQOQ Oracle account, execute the following SQL 
script. Enter this command on one line. For example: 
sqlplus TEST_IQOQ@webvdme  
   @C:\install\database\5_populate_test_iqoq 

At the prompt, enter the TEST_IQOQ password. 



 Installing Empirica Signal release 7.3.3.5.362 

Empirical Signal Installation and Upgrade Instructions 
Copyright © 2000, 2016, Oracle and/or its affiliates. All rights reserved. Page 20 of 41 

2.9 Verify the Empirica Signal Installation 
For Installation Qualification (IQ) and Operational Qualification (OQ) testing, please refer to the 
IQ_Test.doc and OQ_Test.doc files supplied in the product ZIP file from the Oracle Software 
Delivery Cloud. 
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3 Upgrading from Empirica Signal 7.2 to 
7.3.3.5.362 

These instructions apply to upgrades from all previous versions of Empirica Signal 7.2 to the 
most recently released version of 7.3. 

Before you begin an Empirica Signal upgrade, you will need: 

• A username with admin privileges for the Windows 2003 server, and its password. 

• The correct version from the Oracle Software Delivery Cloud. 

• The password for an administrator-level Empirica Signal username. 

• The passwords for the TOPIC_WORKFLOW and webvdme Oracle database accounts. 

• Identification of the server as a 32-bit or 64-bit server. 

• Identification of the version of Empirica Signal 7.2 you are using. 

• Identification of the version of the Oracle Database you are using. 

If your installation uses any custom reports, before you perform the upgrade consult Oracle for 
recommended procedures for retaining those reports. 

3.1  Database Updates 

3.1.1  Running the Database Upgrade Scripts 
1. To stop the webvdme and World Wide Web Publisher service, Open Start > 

Administrative Tools > Services. 

2. Right-click the WebVDME service, and then select Stop. 

3. Right-click the World Wide Web Publishing Service, and then select Stop. 

4. Open the C:\Lincoln\apps\webvdme\bin\ directory. 

5. To uninstall the webvdme service, double-click uninstall_service.bat.   
6. Rename the C:\Lincoln directory to C:\Lincoln.old. 

7. Locate the following SQL scripts in the database.zip file in the product ZIP file from the 
Oracle Software Delivery Cloud and extract them to a temporary location such as 
C:\install: 
update_7_2_to_7_2_P1.sql 

update_twc_7_2_to_7_2_P1.sql 

update_7_2_P1_to_7_3.sql 

update_twc_7_2_P1_to_7_3.sql 

update_7_3_to_7_3_P3.sql 
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8. Open a Command Prompt window and change to the directory containing the upgrade 
scripts. 

9. If you are on Empirica Signal 7.2.149 or greater, skip to step 11. Otherwise, to upgrade the 
Empirica Signal schema from Empirica Signal 7.2.140 to Empirica Signal 7.2.149, enter the 
following command: 
sqlplus webvdme@webvdme @update_7_2_to_7_2_P1 

10. When prompted, enter the password for the webvdme schema. 

The log file update_7_2_to_7_2_P1.log is created in the same temporary location as the 
SQL scripts. 

11. To upgrade Topics schemas from Empirica Signal 7.2.140 to Empirica Signal 7.2.149, enter 
the following command from the topic workflow account (usually topic_workflow): 
sqlplus topic_workflow@webvdme @update_twc_7_2_to_7_2_P1 

The script reports the ID and name of each topic workflow configuration in the account 
TOPIC_WORKFLOW. All topic workflow configurations must be upgraded one at a time. 

12. At the prompt, enter the ID of a configuration (for example, 0), and then type Enter. 
The topic workflow configuration with that ID is upgraded and the log file 
update_twc_7_2_to_7_2_P1.log is created. 

13. After you upgrade to Empirica Signal release 7.2.149, or if you are already on Empirica 
Signal release 7.2.149 or greater, enter the following command to upgrade the Empirica 
Signal schema to Empirica Signal 7.3.333: 
sqlplus webvdme@webvdme @update_7_2_P1_to_7_3 

14. When prompted, enter the password for the webvdme schema. 

The log file update_7_2_P1_to_7_3.log is created in the same temporary location as the 
SQL scripts. 
 
The log file might include the following types of errors, which are expected and can be 
ignored: 
• “Cannot drop constraint – nonexistent constraint” errors for FK_SIGVIEW_PUBLISH_1, 

FK_SIGVIEW_PUBLISH_2, FK_SIGVIEW_PUBLISH_3, FK_SIGNAL_VIEW_1,  
FK_SIGNALCONFIGTABLEGROUP_X, FK_SIGNALCONFIGTABLEGROUP_2,  
FK_SIGNALCONFIG_2, FK_SIGNALCONFIG_4. 

• “column to be modified to NOT NULL is already NOT NULL” errors for 
SIGNALSUMMARY_0 and SIGNALSTATGROUP_0. 

15. To upgrade the Empirica Signal schema from Empirica Signal 7.3.333 to the latest schema, 
enter the following command: 
sqlplus webvdme@webvdme @update_7_3_to_7_3_P3 

16. When prompted, enter the password for the webvdme schema. 
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The log file update_7_3_to_7_3_P3.log is created in the same temporary location as the 
SQL scripts. 

17. To upgrade Topics schemas from Empirica Signal 7.2.149 to Empirica Signal 7.3, enter the 
following command from the topic workflow account (usually topic_workflow): 
sqlplus topic_workflow@webvdme @update_twc_7_2_P1_to_7_3 

18. When prompted, enter the password for the TOPIC_WORKFLOW schema. The log file 
update_twc_7_2_P1_to_7_3.log is created. 

3.2 Install Empirica Signal 7.3 Software 

3.2.1 Setting Up Web Site Files 
1. Locate the Lincoln_x64.zip file in the product ZIP file from the Oracle Software Delivery 

Cloud. For a 32-bit server, use Lincoln.zip instead. Extract the contents of this file to C:\, 
making sure that path names stored in the archive will be used (for example, in WinZip, the 
Use folder names checkbox must be selected). 

2. Locate the SignalX.zip file (where X represents the version number and build, for 
example, Signal-7_3_3_5_362.zip) in the product ZIP file from the Oracle Software 
Delivery Cloud. Extract the contents of this file to the 
C:\Lincoln\apps\webvdme\webapps\web_root\ directory (created automatically by the 
previous step). 

3. Locate the following file depending on your Oracle database version: 

• If you are using Oracle 10g, local the ojdbc14.jar file in the \jdbc\lib folder of the 
Oracle installation directory. 

• If you are using Oracle 11g, locate the ojdbc6.jar file in the \jdbc\lib folder of the 
Oracle installation directory.  

4. Copy the JAR file to the C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\lib 
directory. 

5. Navigate to the C:\Lincoln\IIS\conf\iis_redirect.reg file. If you changed any default 
paths, edit this file to reflect those paths before performing the next step. 

6. To update the registry, double-click the iis_redirect.reg file. Click Yes, and then click 
OK. 

7. In the same directory, double-click the iis_cipher_configuration.reg file. Click Yes, 
and then click OK. 

8. Create a temp directory for the application, for example, D:\Signal. 

Make note of this directory, as it will be needed in several future steps in the installation. 
Note: You might want to delete or archive your old temp directory, usually D:\webvdme. 
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3.2.2 Making Empirica Signal the Default Application (optional) 
1. Open the C:\Lincoln\apps\webvdme\webapps\web_root\index.html file in a text editor 

such as Notepad and change the URL on this line from: 
<META HTTP-EQUIV=REFRESH CONTENT="0; URL=./login.jsp"> 

to: 
<META HTTP-EQUIV=REFRESH CONTENT="0; URL=/webvdme/login.jsp"> 

Then save. 

2. To make Empirica Signal the default application for this IIS installation, copy the 
C:\Lincoln\apps\webvdme\webapps\web_root\index.html file to the 
C:\inetpub\wwwroot directory. Click Yes if prompted to replace. 

3. If making Empirica Signal the Default Application, select the Documents tab, check the 
Enable Default Document [Content] checkbox and set index.html as the top-most 
default document. (Add this document if necessary.) 

3.2.3 Installing the webvdme keys and service 
1. For Windows 2003 only, update the lcalcs.exe utility by following the instructions located at 

http://support.microsoft.com/kb/943043. 

2. Edit the C:\Lincoln\apps\webvdme\bin\install_service.bat file so that the 
WORKING_DIR is the value of the temporary directory from section 3.2.1 Setting Up Web 
Site Files.  

3. Save. 

4. Double-click the install_service.bat file. 

5. After install_service.bat has completed, when prompted, type any key. 

6. Double-click the C:\Lincoln\apps\webvdme\bin\generate_keys.bat file. 

7. After generate_keys.bat has completed, when prompted, type any key. 

8. Right-click the server’s desktop My Computer icon, and then select Manage. 

9. Expand System Tools > Local Users and Groups > Users. 

10. Right-click webvdme_app and select Set Password.  

11. In the Set Password for webvdme_app dialog box, click Proceed. 

12. Change the password to satisfy local site password requirements, and then click OK. Note 
this password for step 15. 

13. Expand the Services and Applications directory, and then select Services. 

14. Right-click the webvdme service and select Properties. 

15. On the Log On tab, select the This account radio button, and then clear the password 
fields and enter the webvdme_app password you just changed. 

16. On the Recovery tab, set First Failure and Second Failure to Restart the Service. 

http://support.microsoft.com/kb/943043
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17. Click OK. 

3.2.4 Migrate data from 7.2 to 7.3 
1. Copy any custom content (such as custom home pages) from the previous installation to the 

new installation. For example, copy your file from:  
C:\Lincoln.old\apps\webvdme\webapps\web_root\customhomes  

to:  
C:\Lincoln\apps\webvdme\webapps\web_root\customhomes 

2. Copy any custom images from the previous installation to the new installation. For example, 
copy your file from:  
C:\Lincoln.old\apps\webvdme\webapps\web_root\image  

to:  
C:\Lincoln\apps\webvdme\webapps\web_root\image 

3. Copy any relevant release notes from the previous installation to the new installation. For 
example, copy release notes file from:  
C:\Lincoln.old\apps\webvdme\webapps\web_root\relnotes 

to:  
C:\Lincoln\apps\webvdme\webapps\web_root\relnotes 

3.3 Configure Properties Files 

3.3.1 Reviewing webvdme.properties 

The webvdme.properties file stores database connection information for Empirica Signal.  

1. Navigate to C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\classes. 

2. Copy the template_webvdme.properties file to the same directory, and name it 
webvdme.properties. 

3. Use a text editor such as Notepad to open the webvdme.properties file. 

4. Review the settings for the following values in the file: 
user=webvdme 

pass=<password> 

connect=jdbc:oracle:thin:@//localhost:1521/ORCL 
sqlldr_connect=webvdme 

5. Modify the password to match webvdme database schema password.  

6. Modify temp_dir=<temporary directory> with the value of the temporary path established in 
3.2.1 Setting up the Web Site Files step 8. 

7. Save the file. 
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Note: You can set the Empirica Signal application to encrypt this password. See the steps in the 
Configure the Empirica Signal Application section. 

3.3.2  Reviewing listener.properties 

The listener.properties file stores information used by Empirica Signal data mining. 

1. Navigate to C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\classes. 

2. Copy the template_listener.properties file to the same directory, and name it 
listener.properties. 

3. Use a text editor such as Notepad to open the listener.properties file. 

4. Edit values as needed, for example, values for Oracle 10g or Oracle 11g. 

5. Save the file.  

3.3.3 Creating webvdme-fonts.properties 
The webvdme-fonts.properties file stores font information used by Empirica Signal.  

1. Navigate to the C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\classes 
directory. 

2. Copy the template_webvdme-fonts.properties file to the same directory, and rename it 
webvdme-fonts.properties. 

3.4 Set permissions 
1. Navigate to C:\Lincoln\apps\webvdme\bin. 

2. Locate the C:\Lincoln\apps\webvdme\bin\set_permissions.bat file  

3. Optionally grant permission to a Windows group of non-administrator users who may require 
limited access to the \web_root application directory. You may grant access to users who 
execute Signal Management and deploy data releases. For example, a non-administrator 
user who copies the data release notes to the \web_root\relnotes directory requires this 
limited access. Do the following: 

a. Edit the C:\Lincoln\apps\webvdme\bin\set_permissions.bat file. 

b. Locate the following lines: 
REM - 

REM - Local Administrators group 

REM - 

REM SET ADMIN_GROUP=Signal Operators 

c. Remove REM from the REM SET ADMIN_GROUP line. 

d. Replace Signal Operators with the appropriate Windows user group that requires 
access. 
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4. Save your changes. 

5. For Windows 2008, right-click the set_permissions.bat file, and then select Run as 
administrator. 
Or 

For Windows 2003, double-click the set_permissions.bat file. 

6. After set_permissions.bat has completed, when prompted, type any key. 

3.5 Start the Empirica Signal Service 
1. Right-click the webvdme service, and then select Start. 
2. Right-click the World Wide Web Publishing Service, and then select Start. 

3.6 Verify the Empirica Signal Upgrade 
For Upgrade Qualification (UQ) and Operational Qualification (OQ) testing, please refer to the 
UQ_Test.doc and OQ_Test.doc files supplied in the product ZIP file from the Oracle Software 
Delivery Cloud. 

3.7 Reviewing ldap.properties 
For LDAP configurations, the ldap.properties file stores LDAP configuration information. 
For information on editing the LDAP configuration, see the Configuring Empirica Signal for Use 
with LDAP topic in the Empirica Signal Help. 
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4 Upgrading from Empirica Signal 7.3 to 
7.3.3.5.362  

This section provides instructions for upgrading to Empirica Signal 7.3.3.5.362 from one of the 
following releases: 

• 7.3.333 

• 7.3.337 

• 7.3.341 

• 7.3.3.0.354 

• 7.3.3.1.356 

• 7.3.3.2.359 

• 7.3.3.3.360 

Before you begin an Empirica Signal upgrade, you will need: 

• A username with admin privileges for the Windows 2003 or Windows 2008 server, and its 
password. 

• The correct version from the Oracle Software Delivery Cloud. 

• The password for an administrator-level Empirica Signal username. 

• The passwords for the webvdme accounts. 

• Identification of the server as a 32-bit or 64-bit server. 

• Identification of the version of Empirica Signal 7.3 you are using. 

• Identification of the version of the Oracle Database you are using. 

If your installation uses any custom reports, consult Oracle before you perform the upgrade for 
recommended procedures to retain those reports. 

4.1  Database Updates 

4.1.1  Running the Database Upgrade Scripts 
1. To stop the webvdme and World Wide Web Publisher service: 

a. Open Start > Administrative Tools > Services. 

b. Right-click the webvdme service, and then select Stop. 

c. Right-click the World Wide Web Publishing Service, and select Stop. 

If you are on Empirica Signal 7.3.3.0.354, 7.3.3.1.356, 7.3.3.2.359, or 7.3.3.3.360, skip to 
section 4.2. Otherwise, to upgrade the Empirica Signal schema from Empirica Signal 7.3 to 
Empirica Signal 7.3 Patch 3: 
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2. Locate the following SQL script in the database.zip file and extract it to a temporary 
location such as C:\install: 
update_7_3_to_7_3_P3.sql 

3. Open a Command Prompt window and change to the directory containing the upgrade 
script. 

4. To upgrade the Empirica Signal schema from Empirica Signal 7.3 to Empirica Signal 7.3 
Patch 3, enter the following command: 
sqlplus webvdme@webvdme @update_7_3_to_7_3_P3 

5. When prompted, enter the password for the webvdme schema. 
The log file update_7_3_to_7_3_P3.log is created in the same temporary location as the 
SQL scripts. 

4.2 Install Empirica Signal release 7.3 software 
1. Delete the following directory: 

C:\Lincoln\jdk1.6 

2. Locate the file jdk1.6.0_81.zip on the product ZIP file. For a 64-bit server, use 
jdk1.6.0_81_x64.zip instead. Extract the contents of this file to the following directory:  
C:\Lincoln 

3. Navigate to the following directory: 
C:\Lincoln\apps\webvdme\bin 

4. For Windows 2008, right-click the uninstall_service.bat file, and select Run as 
administrator.  
Or 

For Windows 2003, double-click the uninstall_service.bat file. 

5. When prompted in the cmd.exe window, press any key. 

6. Delete the following directory: 
C:\Lincoln\apache-tomcat-6.0.NN 

7. Locate the apache-tomcat-6.0.41.zip file on the product ZIP file. For a 64-bit server, use 
apache-tomcat-6.0.41_x64.zip instead. 

8. Extract the contents of this file to the C:\Lincoln directory, making sure that path names 
stored in the archive are used. For example, in WinZip, select the Use folder names 
checkbox. 

9. Locate the isapi_redirect-1.2.40.zip file on the product ZIP file. For a 64-bit server, 
use isapi_redirect-1.2.40_x64.zip instead.  

10. Extract the contents of this file to the C:\Lincoln\IIS\bin directory. If prompted, confirm 
the replacement of files. 
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11. Navigate to the following directory: 
C:\Lincoln\apps\webvdme\bin 

12. Right-click the install_service.bat file, and select Properties.  

13. On the General tab, clear the Read-only checkbox, and click OK. 

14. Edit the install_service.bat file and do the following: 

a. For the line that begins with set CATALINA_HOME, replace apache-tomcat-6.0.NN with 
apache-tomcat-6.0.41 

b. For the section of the file titled Creating service user, comment out the last three 
lines by adding REM at the beginning of the line.   

All lines in the section should begin with REM. 

15. For Windows 2008, right-click the install_service.bat file, and then select Run as 
administrator.  
 
Or 
 
For Windows 2003, double-click the install_service.bat file. 

16. Right-click the uninstall_service.bat file, and select Properties.  

17. On the General tab, deselect the Read-only checkbox, and click OK. 

18. Edit the uninstall_service.bat file and, for the line that begins with set 
CATALINA_HOME, replace apache-tomcat-6.0.NN with apache-tomcat-6.0.41. 

19. On the server, right-click My Computer, and select Manage. 

20. Expand the Services and Applications directory, and select Services. 

21. Right-click the webvdme service, and select Properties. 

22. On the Log On tab, do the following: 

a. Select the This account radio button. 

b. Click Browse. 

c. In the Edit field, enter webvdme_app. 

d. Click the Check Names button. 

e. Click OK. 

f. Clear the password fields and enter the password that you established for 
webvdme_app in a previous installation or upgade. If you do not know the password, 
see Installing the webvdme keys and service, steps 7 through 11, for information about 
resetting the password. 

23. On the Recovery tab, set First Failure and Second Failure to Restart the Service. 

24. Click OK. 
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25. If it already exists, delete the following directory: 
C:\Lincoln\apps\webvdme\webapps\web_root.old  

26. Create the C:\Lincoln\apps\webvdme\webapps\web_root.old directory and move the 
contents of C:\Lincoln\apps\webvdme\webapps\web_root to web_root.old. 

27. Locate the signalX.zip file (where X is version number and build, such as Signal-
7_3_3_5_362.zip) in the product ZIP file from the Oracle Software Delivery Cloud. Extract 
the contents of this file to the following directory, making sure that path names stored in the 
archive will be used. For example, in WinZip, select the Use folder names checkbox. 
C:\Lincoln\apps\webvdme\webapps\web_root\ 

28. For a 64-bit server, update 32-bit JRE by doing the following: 

a.  Delete the following directory: 
C:\Lincoln\apps\webvdme\webapps\jre 

b. Locate the jre1.6.0_81_x32.zip file in the product ZIP file from the Oracle Software 
Delivery Cloud. 

c.  Extract the contents of this file to the following directory, making sure that path names 
stored in the archive will be used. For example, in WinZip, select the Use folder names 
checkbox. 
C:\Lincoln\apps\webvdme\webapps\ 

29. Locate the following file depending on your Oracle database version and copy the file to 
C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\lib. 

• If you are using Oracle 10g, locate the ojdbc14.jar file in the \jdbc\lib folder of the 
Oracle installation directory. 

• If you are using Oracle 11g, locate the ojdbc6.jar file in the \jdbc\lib folder of the 
Oracle installation directory.  

30. Copy the listener.properties, webvdme.properties,  
webvdme-fonts.properties, and optional ldap.properties files from the previous 
installation to the new installation. Copy these files from: 
C:\Lincoln\apps\webvdme\webapps\web_root.old\WEB-INF\classes 

to:  
C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\classes 

31. If you have created or included any custom content (home pages or logos), then copy those 
files back from the previous installation to the new installation. For example, copy your home 
page file from:  
C:\Lincoln\apps\webvdme\webapps\web_root.old\customhomes 

to:  
C:\Lincoln\apps\webvdme\webapps\web_root\customhomes 

Or copy your custom logo file from:  
C:\Lincoln\apps\webvdme\webapps\web_root.old\image 
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to:  
C:\Lincoln\apps\webvdme\webapps\web_root\image 

32. Copy any relevant release notes from the previous installation to the new installation. For 
example, copy release notes files from:  
C:\Lincoln\apps\webvdme\webapps\web_root.old\relnotes 

to:  
C:\Lincoln\apps\webvdme\webapps\web_root\relnotes 

33. Delete the contents of the following directory: 
C:\Lincoln\apps\webvdme\work 

34. If you are on Empirica Signal 7.3.3.0.354, 7.3.3.1.356, 7.3.3.2.359 or 7.3.3.3.360, skip to 
section 4.3.   

35. Locate the Upgrade directory in your installation media. 

36. If you are on Empirica Signal 7.3.341 or earlier, copy the following files to 
C:\Lincoln\apps\webvdme\bin, overwriting the existing files if prompted: 

• EmpiricaPropPassword.jar 

• ldap_search_password.bat 

• obiee_auth_password.bat 

• set_permissions.bat 

37. If you are on Empirica Signal 7.3.341 or earlier, copy the following files to 
C:\Lincoln\apps\webvdme\lib, overwriting the existing files if prompted: 

• obiee_auth.properties 

• ESAPI.properties.in 

38. If you are on Empirica Signal 7.3.341 or earlier, navigate to the following directory and 
delete the ESAPI.properties file, if it exists: 
C:\Lincoln\apps\webvdme\lib 

39. If you are on Empirica Signal 7.3.341 or earlier, generate instance-specific keys. 
 
For Windows 2008, right-click the C:\Lincoln\apps\webvdme\bin\generate_keys.bat 
file, and then select Run as administrator. 
Or 

For Windows 2003, double-click the 
C:\Lincoln\apps\webvdme\bin\generate_keys.bat file. 
 
After generate_keys.bat has completed, when prompted, type any key. 
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40. If you are on Empirica Signal 7.3.341 or earlier, copy the new LDAP and ACL properties 
from the template_webvdme.properties file to your existing webvdme.properties file. 
Copy the following sections: 
# Configure the following property only when you implement LDAP authentication 
# and Empirica Signal should use an ldap configuration file other than the  
# default value of ldap.properties. For more information on LDAP template  
# files and implementing LDAP, see the Empirica Signal Help. 
#ldapPropertyFile= 
# 
# Configure the following properties when you implement IP access control  
# lists and remote user IP identification. For more information, see the  
# Empirica Signal Help. 
# IP Access Control Lists properties. 
# Enables or disables IP access control lists. 
IPACL_ENABLE=FALSE 
# Determines where the source IP is obtained.  
# Evaluated only when IPACL_ENABLE=TRUE. 
#IPACL_SOURCE=HEADER 
# Indicates the HTTP header that contains the IP address. 
# Evaluated only when IPACL_ENABLE=TRUE and IPACL_SOURCE=HEADER. 
#IPACL_HEADER_NAME=FORWARDED-FOR 
# Determines how the IP address is parsed from a header value. 
# Evaluated only when when IPACL_ENABLE=TRUE and IPACL_SOURCE=HEADER. 
#IPACL_HEADER_VALUE_REGEX=\b\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3}\b 
# Defines the white list of IP addresses allowed to access the application. 
# Required and evaluated only when IPACL_ENABLE=TRUE. 
#IPACL_ALLOW=192.168.1.50, 192.168.1.100-192.168.1.200 
# Remote User IP Identification properties. 
# Determines where the source IP is obtained for auditing and user  
# identification. 
#RUIPID_SOURCE=HEADER 
# Indicates the HTTP header that contains the IP address.  
# Evaluated only when RUIPID_SOURCE is set to HEADER. 
#RUIPID_HEADER_NAME=FORWARDED-FOR 
# Determines how the IP address is parsed from a header value.  
# Evaluated only when RUIPID_SOURCE is set to HEADER. 
#RUIPID_HEADER_VALUE_REGEX=\b\d{1,3}\.\d{1,3}\.\d{1,3}\.\d{1,3}\b 

from:  
C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\classes\ 
template_webvdme.properties 

to: 
C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\classes\ 
webvdme.properties 

41. If you are on Empirica Signal 7.3.341 or earlier, update your server.xml file. Do the 
following: 

a. Navigate to C:\Lincoln\apps\webvdme\conf. 

b. Modify the server.xml file to include useHttpOnly in the <context> tag: 
<Context path="/webvdme" docBase="web_root" debug="0" privileged="true" 
useHttpOnly="true"> 
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Reviewing ldap.properties 
For LDAP configurations, the ldap.properties file stores LDAP configuration information. 
For information on editing the LDAP configuration, see the Configuring Empirica Signal for Use 
with LDAP topic in the Empirica Signal Help. 

4.3 Set permissions 
1. Navigate to C:\Lincoln\apps\webvdme\bin. 

2. Locate the C:\Lincoln\apps\webvdme\bin\set_permissions.bat file. 

3. Optionally grant permission to a Windows group of non-administrator users who may require 
limited access to the \web_root application directory. You may grant access to users who 
execute Signal Management and deploy data releases. For example, a non-administrator 
user who copies the data release notes to the \web_root\relnotes directory requires this 
limited access. Do the following: 

a. Edit the C:\Lincoln\apps\webvdme\bin\set_permissions.bat file. 

b. Locate the following lines: 
REM - 

REM - Local Administrators group 

REM - 

REM SET ADMIN_GROUP=Signal Operators 

c. Remove REM from the REM SET ADMIN_GROUP line. 

d. Replace Signal Operators with the appropriate Windows user group that requires 
access. 

e. Save your changes. 

4. For Windows 2008, right-click the set_permissions.bat file, and then select Run as 
administrator. 
Or 

For Windows 2003, double-click the set_permissions.bat file. 

5. If errors occur while set_permissions.bat is running, you must take ownership, 
recursively, of C:\Lincoln\apps\webvdme and D:\Signal, and then repeat step 5. 

6. After set_permissions.bat has completed, when prompted, type any key. 

4.4  Start the Empirica Signal Service 
1. Right-click the server’s desktop My Computer icon and select Manage. 

2. Expand the Services and Applications directory, and then click Services. 

3. Right-click the webvdme service and select Start. 
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Alternatively, type net start webvdme in a command prompt. 

4. Right-click the World Wide Web Publishing Service, and select Start. 

4.5 Verify the Empirica Signal Upgrade 
For Upgrade Qualification (UQ) and Operational Qualification (OQ) testing, please refer to the 
UQ_Test.doc and OQ_Test.doc files supplied in the product ZIP file from the Oracle Software 
Delivery Cloud. 

You can verify the Empirica Signal version upon successful upgrade on the About page: 

1. Click Settings.  

The Settings page appears. 

2. Click About.  
The About page appears. 
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5 Upgrading from Empirica Signal 7.3.3.4.361 
to 7.3.3.5.362 

This section provides instructions for upgrading to Empirica Signal 7.3.3.5.362 from Empirica 
Signal 7.3.3.4.361. 

Before you begin an Empirica Signal upgrade, you will need: 

• A username with admin privileges for the Windows 2003 or Windows 2008 server, and its 
password. 

• The correct version from the Oracle Software Delivery Cloud. 

• The password for an administrator-level Empirica Signal username. 

5.1 Install Empirica Signal release 
1. To stop the webvdme and World Wide Web Publisher service: 

a. Open Start > Administrative Tools > Services. 

b. Right-click the webvdme service, and then select Stop. 

c. Right-click the World Wide Web Publishing Service, and select Stop. 

2. Delete the two files Signal-7_3_3_4_361.jar and SignalTopicsCommon-1_0_0_0_100.jar 
from the following directory: 
 
C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\lib\ 

3. Locate the signal-7_3_3_5_362.zip file in the product ZIP file from the Oracle Software 
Delivery Cloud. Extract the contents of this file to a temporary directory, for example, 
D:\temp\Signal-7_3_3_5\, making sure that path names stored in the archive will be 
used. For example, in WinZip, select the Use folder names checkbox. 

4. Copy the two files Signal-7_3_3_5_362.jar and SignalTopicsCommon-
1_0_0_0_101.jar from this directory: 
 
D:\temp\Signal-7_3_3_5\WEB-INF\lib\ 
  
to this directory 
 
C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\lib\ 

5. Copy the file Empirica Signal 7.3.3.5.362 Release Notes.pdf from this directory: 
D:\temp\Signal-7_3_3_5\relnotes 
 
to this directory 
 
C:\Lincoln\apps\webvdme\webapps\web_root\relnotes 
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6. Delete all Empirica Signal Release Notes pdf files for versions prior to 7.3.3.5 in the 
directory: 
 
C:\Lincoln\apps\webvdme\webapps\web_root\relnotes 

 

5.2 Set permissions 
1. Navigate to C:\Lincoln\apps\webvdme\bin. 

2. Locate the C:\Lincoln\apps\webvdme\bin\set_permissions.bat file. 

3. Optionally grant permission to a Windows group of non-administrator users who may require 
limited access to the \web_root application directory. You may grant access to users who 
execute Signal Management and deploy data releases. For example, a non-administrator 
user who copies the data release notes to the \web_root\relnotes directory requires this 
limited access. Do the following: 

a. Edit the C:\Lincoln\apps\webvdme\bin\set_permissions.bat file. 

b. Locate the following lines: 
REM - 

REM - Local Administrators group 

REM - 

REM SET ADMIN_GROUP=Signal Operators 

c. Remove REM from the REM SET ADMIN_GROUP line. 

d. Replace Signal Operators with the appropriate Windows user group that requires 
access. 

e. Save your changes. 

4. For Windows 2008, right-click the set_permissions.bat file, and then select Run as 
administrator. 
Or 

For Windows 2003, double-click the set_permissions.bat file. 

5. If errors occur while set_permissions.bat is running, you must take ownership, 
recursively, of C:\Lincoln\apps\webvdme and D:\Signal, and then repeat step 5. 

6. After set_permissions.bat has completed, when prompted, type any key. 

5.3  Start the Empirica Signal Service 
1. Right-click the server’s desktop My Computer icon and select Manage. 

2. Expand the Services and Applications directory, and then click Services. 
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3. Right-click the webvdme service and select Start. 
Alternatively, type net start webvdme in a command prompt. 

4. Right-click the World Wide Web Publishing Service, and click Start. 

5.4 Verify the Empirica Signal Upgrade 
For Upgrade Qualification (UQ) and Operational Qualification (OQ) testing, please refer to the 
UQ_Test.doc and OQ_Test.doc files supplied in the product ZIP file from the Oracle Software 
Delivery Cloud. 

You can verify the Empirica Signal version upon successful upgrade on the About page: 

1. Click Settings.  

The Settings page appears. 

2. Click About.  
The About page appears. 

5.5 Upgrade to the Latest Java 1.6 Update 
Oracle recommends that you also upgrade to the latest update of Java 1.6 by following the 
instructions in the document Empirica JDK Upgrade Instructions.pdf. 
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Appendix A: Configure Signal for single sign-
on (SSO) [OPTIONAL] 
This section applies only to companies that plan to configure Signal for an SSO environment. 
This is advanced, optional functionality. For more information, see the Empirica Signal Online 
Help.  

Before configuring Signal for SSO, you must install and configure Oracle Access Manager 
(OAM). 

A.1 Configure Signal for SSO 

1. Navigate to C:\Lincoln\apps\webvdme\webapps\web_root\WEB-INF\classes. 

2. Open webvdme.properties and uncomment the properties: 
sso.plugins=com.oracle.hsgbu.empirica.sso.EmpiricaSsoPlugin 
sso.EmpiricaSsoPlugin.username.header=oam-remote-user 

3. Optionally, enter an SSO logout URL for logout: 

sso.EmpiricaSsoPlugin.logoutRedirectUrl= 

4. Configure the session timeout to be longer than the SSO timeout. 

The default Signal session timeout is 30 minutes. Modify WEB-INF/web.xml and <session-
timeout> to be longer than the SSO session timeout. 

5. Configure the Signal server for native login: 

a. Edit /Lincoln/apps/webvdme/conf/server.xml. 
b. Under <Service name="Catalina">, add 

<Connector address="127.0.0.1" port="8080" protocol="HTTP/1.1" 
connectionTimeout="20000" redirectPort="8443" /> 

c. Enter an available port number on the server for the port attribute. 

6. Restart the Signal service. 
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A.2 Validating SSO 
1. Open a browser window and type the Signal URL. 

2. At the login prompt, enter your SSO username and password. 

The Signal home page appears. 

3. On the Signal server, start a browser and enter the Signal URL using the port number for 
native login that you set in step 5 in Configure Signal for SSO. 

4. At the Signal login prompt, enter a Signal username that is a superuser and enter the 
password. 

The Signal home page appears. 
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